Viewing and Post-Processing Results

Calibration of numerical models requires use of post-processed model output in
order to compare with measurements and make incremental changes. This section
gives guidance on how to extract and process data from model results, and
examples of measured data to compare results with. Alternatively, the model
results can be exported, and comparisons can be made using different programs,
such as Matlab, Tecplot, but some options within SMS can help with repetitive
testing and comparisons.

Water Levels & Currents

The first stage in calibration of a numerical hydrodynamic model is to accurately
represent measured tides (or water levels) and currents. The number of calibration
measurement sites required for sufficient model calibration increases with larger
domains and increased complexity in processes.

Of the three main data sources required for hydrodynamic calibration
(geomorphic, forcing, and field data), inaccurate knowledge of, or mistakes in
conversion between datums is the most common underlying factor in poor model
calibration. Model calibration cannot be achieved without proper representation
of datums. Some examples of field data typically used for calibration of
hydrodynamics include fixed water level gauges, fixed Acoustic Doppler
Velocimeters (ADV) and Acoustic Doppler Current Profilers (ADCP) and
roaming or boat-mounted ADCPs. Fixed data can be assessed over a time series,
whereas boat-mounted data are collected at specified locations over time
intervals. If roaming data are collected continuously, they must be assessed
spatially and temporally.

For hydrodynamic data, the most common forms of measurements are recorded
either temporally at a station, temporally at a fixed spatial extent, or spatially at
relatively singular times. For example, a tide gauge is stationary, but a Horizontal
Acoustic Doppler current meter (H-ADCP) may collect temporal measurements at
multiple points. Because the CMS is a 2D model, ADCP measurements at
multiple locations should be depth-averaged, as would be an upward-looking
ADCP, for model and data comparisons. Similarly, a field campaign of depth-
averaged current measurements collected at transects are all contemporaneous, but
there are multiple time periods to compare.

With forcing data and corresponding datums, the accuracy and detail of the
geomorphic parameters, such as bathymetry, sediment characterization, and
structure definition, also need to be checked before hydrodynamic calibration can
be achieved. The most important of these is bathymetry, which can have several
issues typically associated with quality control, data density, interpolation, and
grid resolution and domain size. A good example of this is a poorly resolved
small channel in the far reaches of a bay, such as that in the northern portion of
the Shark River estuary (Figure 1). Although lower velocities may be passing
through this channel, and there may be little interest in morphology change here, it
may be integral to providing the conduit of tidal flow to a shallow bay platform.
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Figure 1. Northern portion of the Shark River estuary.

Figure 2 shows the closest locations of water-level gauges to Shark River Inlet.
Sandy Hook and Atlantic City, NJ, are two ocean pier-mounted gauges
approximately 30 and 100 miles away from Shark River Inlet, respectively. Both
NOAA gauges were evaluated against the Belmar tide gauge using the tidal
constituents of one year, and Sandy Hook was found to have the closest
amplitudes and phases. Measured tides from Sandy Hook were used to force the
offshore boundary condition. The calibration period that the model was evaluated
on was for the 13-hour tidal cycle over which field measurements were collected
on 20 August 2009.

B Shark River
g i

Flood

Tidal

Delta
Belmar ;
Tide Gauge ;|

Figure 2. ocation of NOAA (red) and USGS (blue) water level gauges.
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Display Options

The results of the CMS calculated hydrodynamics can be viewed and compared to
measured results in a number of ways. Scalar results are typically in planar view
and are illustrated by color representing magnitude, and vector results by arrow
lengths representing magnitude and direction. Color setting can be manipulated in
the overall Display Options, or individually for each dataset.

e Open a solution file for the water level output (* wse.h5) and right click
on the Water Elevation dataset, select Dataset Contour Options.

¢ In the Contours tab, adjust the color settings and the value range to that in

Figure 3.

Figure 4 illustrates the new color scheme for displaying the water surface

elevation.
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Figure 3. Contour tab settings for color display and value ran'ge. Note the
blue colors were selected for the visible range.
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Figure 4. Water surface elevation color map modified.

Currents are automatically given in vector format as the solution files are
generated. These can be converted into Vx and Vy components, or into magnitude
and direction. If the model results are compared to simple magnitude
measurements, then the magnitude dataset is appropriate. If the model results will
be compared to measurements in E-W and N-S components, care should be taken
to compare the correct derivative of the vector format. Because the vectors are
based on the Cartesian grid’s orientation, be sure to convert with respect to the
axis difference.

e Right click on the current vector dataset and select Vector to Scalars.
Select Vx and Vy, and this gives the x and y components of the current
velocity. Current speed is saved in the Current Magnitude dataset. The
color component of the magnitude can be selected along with the vector
of the current velocity.

e Open the Display Options and go to the Quadtree/Vector tab. Change the
vectors to the below settings (Figure 5) to view the vectors over a
prescribed gridding. (Note that individual vectors at each cell is difficult
to visualize for the whole domain and only helpful when zoomed in very
close.)
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Figure 5. Vector Display options set for a gridded display across the
domain.

Figure 6 shows an example of displaying current magnitudes with color contours
and the current direction with vectors.
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Figure 6. Vectors and color contours set for displaying current magnitude
(color) and direction (vectors). Note that the vectors are slightly scaled on
this setting to reflect magnitude.

Importing water level measurements into SMS

To compare the measured data within SMS, the measurements must be brought
into the program and into a comparable format. As a simple example of
comparing tidal data to calculated tides, the USGS Belmar tide data is given in
the folder
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Workshop\Final\Data in the Tide Comparison AUG09 Workshop.xls file. To
import this data, it must be brought in as observational data within the
Observation Map Module.

e In the Cartesian Module, go to Display, Plot Wizard, and select Time
Series Plot. Select scalar, and the WSE as the dataset. (Note it takes
some time to populate a plot in SMS.)

e Change the map module Default Coverage type to Observation and add a

Feature Point
Figure 2.

to the approximate location of the tide gauge shown in

e Right click on this feature point (Figure 7) and select attributes.
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Figure 7. Observation point placed at the location of the Belmar tide
station.

o In the Attributes, check the Trans box in measurements, and select 2D
Cartesian under Module, and the Water Elevation dataset (Figure 8). If
your Observe Point is checked, an Options box should appear under the
Time Series column. Select this and import the Belmar Tide.xys file.

Time series of the measured water levels can be manually pasted here. A file of
measured water levels is provided and available for /mport: Belmar Tide
Input.tsd.
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Figure 8. Input of time series water surface elevation data into an

observation point.

Calculated water level plotting from Feature Points

Time series plots of water surface elevation can be created through the SMS
plotting package. The steps to generate a plot are:

Select Display | Plot Wizard | Time Series and select Next. The Function is
Scalar, and the Water Elevation scalar dataset should be selected with the
full time period (Figure 9).
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Figure 9. Plot Wizard for time series data (top); Time Series plot of Water
Elevation (bottom).

e The plots can be updated by right clicking the graph window and selecting
Plot Data. Also, the time frame can be modified.

e Changing the location of the Feature Point by dragging the point will also
automatically update any graph open within SMS. Note that moving
Feature Points that are extracting large datasets may take a considerable
amount of time to reload.

Extensive statistical analysis of time series water levels is not available in SMS.
However, it is convenient to extract this information from SMS which can be used
in other software or Microsoft Excel.

e To extract the raw data for use in other software right-click on the graph
window and select Export. In the Exporting Time Series window, select
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Export|Text/Data, Export Destination|File (and specify a location) and
select Export. Change the Export Style to Table and Row vs. Column to

Points/Subsets (Figure 10). Export.
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Figure 10. Export Wizard for plotted data.

be highlighted and copied to another program.
Other options for the display plot can be found on the XMS Wiki
(http://www.xmswiki.com/xms/SMS:2D_Plots).

CMS-calculated water level variation is compared with water levels from the
Belmar gauge (location shown in Figure 2) and given in Figure 11.
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To view the raw data (and another way to extract) right-click on the graph
window and select View Values. The data are presented in a table that can
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Figure 11. Observed time series of water level at Sandy Hook and Belmar
(“Bay”) and calculated water level at Belmar.

If time series data for the model were not set to the same interval as the measured
data, there are filtering options within the data calculator. Reducing output (water
level) from the solution:

e To create a 30-minute dataset of water levels from the original 6-minute
output, go to Data, Data Set Toolbox, and under the Tools section, select
Temporal, Sample Time Steps (Figure 12).
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Figure 12. Sampling time steps of the Water_Elevation scalar dataset in the

Dataset Toolbox.

o Seclect the Water Elevation dataset under the solution data tree and create

an Output dataset name at the bottom.

e Set the Start time to the beginning of the series and the end time to the end
by selecting the time under 7Time Steps and selecting the associated button
below. Change the time step to 30 minutes (or 0.5 hours), click Sample.

Depth-average down-looking ADCP current data were measured along three
transects in Shark River Inlet during the calibration time period in August 2009.
These data were processed with off-the-shelf software, where velocity was binned
into depth measurements throughout the water column and converted into a .GIS
file. To display preprocessed measured velocities, they must be converted into an
XYZ format with additional data (velocity and direction, or x- and y-components,
Vx and V)) in additional columns. SMS will recognize both the XYZ data and
assign extra scalar or vector datasets to the imported files.

Importing GIS-type files from D-ADCP current measurements output into SMS:

e Open the provided file, SRI082009 DAV 1300.GIS, in the folder
Workshop\Final\Data and select Use Import Wizard (An excel version
of the text file is also provided in the folder). Select space/tab delimited
if not already checked and click Next, and select the X, Y, Z, Vector X
and Vector Y columns (Figure 13). Change the Header of the Vector X
& Y columns so they are the same (Vector), otherwise an error incurs
when importing the file.
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Figure 13. Read in vector files using Import Wizard.

All of the files were imported into SMS similarly as the time series data in the
above section. All the data imported included X, Y, Z, Vx, Vy, Mag, and Dir for
all three transects at a particular measurement time period. The files (under

Workshop\Final\Data\SMS) have been converted into scatter datasets for quick
import in SMS for viewing.

Import (drag and drop) one or two of the .h5 files (e.g.,
SHARKS820 HOURLY -SR1082009 DAV _1100.h5). In Display Options,

under Scatter, select velocity vectors and adjust the vector settings tab
(Figure 14).

Calculated and measured vector components can be compared here. For a
general estimate of comparison of the magnitude, convert one of the
measurement files’ vectors to magnitude and direction (right click, vector

to scalars). This can be compared to the calculated magnitude for a rough
estimate.

The scalar value of the measured data is in centimeters. Create a new

dataset in meters using the Data Set Toolbox/Data Calculator (Figure
15).
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Figure 14. Example of the vector display along the measured transects.
Note the vectors are scaled to the magnitude, and these scales can be
manipulated in the Scatterset Vector tab.
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Figure 15. Data calculator used to convert the vector magnitude from
centimeters to meters for comparison to the calculated velocity magnitude.

e To display the scatter points with colors representing the flow, go to the
Scatter Tab under the Display Options, and select the Use Color Contour
Scheme under Points. Make the points a size 10 and they will be visible
and the color differences noticeable as in Figure 16.
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Figure 16. Color options turned on for scatter points.

To compare the measured current velocity data to calculated, the data must be in
SMS in this format, where XYZ data overlay the proper region and the units of
the measurements are the same. Both datasets can be viewed and extracted within
the SMS through the use of observation arcs. The arcs must be set along the
transect line and have enough points to illicit one value per cell, but not too many
where there will be duplicate calculated values. The imported measured datasets
are much denser than the cell coverage. Below describes how to plot a transect or
observation arc, through the measured points that will display both measured
point data and calculated data across a distance.

Displaying measured and calculated currents in SMS

e Following the above section, the current velocity file is displayed similar
to Figure 17. Draw three observation arcs over each of the three transects.
Directional arrows will display, and the direction of the arc should reflect
ebbing or flooding. If the arrows face the flooding direction, flood
currents will be positive, and ebb currents will be negative.

e Redistribute the vertices on the arcs (they should not have any yet) to a
value similar to the number of cells across each transect. E.g., Transect 1
(main channel) should have 25-30 vertices.
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Figure 17. Example of a feature arc with arrows in the ebb direction.
Redistribute Vertices, Reverse Arc, and other options are available in the
drop-down menu.

e To plot, select Plot Wizard from Display, and select an Observation
Profile. In Step 2, select one of the arcs (uncheck others), and under Extra
Profile select Model Intersections. Figure 18 illustrates everything selected
for plotting the measured and calculated data for the specific time of the
transect measurement.
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Figure 18. Plot Wizard data options for displaying measured and calculated
data from an observation arc.

e Specify the datasets to be plotted, the Current Magnitude under the grid
and the Vector Magnitude under the scatterset data. Select the date and
time the transect was measured, which was 20 August 2009 at IPM GMT.

e The resultant plot is shown in Figure 19, where the closest points from the
measured data were plotted as distance across the arc, and model grid cell
centers are where numbers are extracted for the calculated data. Data can
be extracted from the plot similarly to the ways defined in the water level
extraction section at the beginning of this section.

CMS Post-Processing — Page 16



Profile
Time Step: 19 13:00:00
0'5 N A “a e e s T S L Bt B R o
i T .
0.4 — ‘i:, : A ,C‘ \‘n '3'4\ = 7
i RA N e AL [
AN S N U { SN SN AN
® 0.3 A L LY = P A
‘_3‘, '- ’/‘ i |9, ;ﬂ:" t]
> AN/ ’ Vi A
0.2*ﬁ ‘/. i ‘4‘ “-’.‘A
i ”«’;‘a. AP
\ AN S
014 & ¢
}! e
[ | [ |
0 50 100 150 200
Distance
@ Arc1, Current_Magnitude 4 Arc1,V13 CurMag (m)

Figure 19. Plotted measured and calculated data from the larger
observation arc to the East. Note that the positive direction reflects the
observation arcs direction.

Displaying 2D current/sediment transport fields with wind/wave compass

Coastal circulation and sediment transport are primarily driven by wind and wave
fields. When viewing/examining spatial and temporal variability of current and
sediment transport, it will help the analysis to show wind and wave forcing
simultaneously. In SMS a compass plot of wind or waves can be created with the
display of current or sediment transport fields.

The following steps demonstrate how to plot a wind compass synchronized with
temporally varying flow fields.

e Switch to the Map Module, right-click Map Data, select New Coverage,
Spatial Data, and name the coverage, Wind Compass (Figure 20).

e C(Create a feature point in the Spatial Data coverage.

e Click the Select Feature Point button and select the generated point, then
right-click it and select Add -> Compass Plot (Figure 21).

CMS Post-Processing — Page 17



Feat

- e Edt
SECl Eask

?
= g usroe Dt o Current
h's — 1.50 (m/s
P 0.00 {m/s
1.5
P |
# 1.2
i
= 0.9
‘
e e
Hew Coverage *
Coverage Type
e Progerty -
CGad Generator
Location
Maoging
Mesh Genertor
(19 Obsenvation Obmorvation
& 1@ GIS Daxa o
15, Werd imagery ki B

= B Awotmticn Data

Meters
0 100 200

(5]
ftEEEEr@YSYE T FuUE

Figure 20. Generate a Spatial Data Covergae.
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e Click the Select Feature Point button and right-click it and select Add ->
Time Series.

o Click Import to read “WIND” from a *tsd file or copy/paste wind
information from an open Excel file (Figure 22).

e Click Select Compass Plot -> Properties and check the Show box under
Spatial Data (Figure 23).
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Figure 23. Link wind data with compass plot.
Sediment Transport

Sediment transport rates can be used to calculate sediment statistics, sediment
pathways, fluxes across arcs, and balances over polygonal areas. Several sediment
transport statistics can be calculated during the simulation and output at any time.
These statistics include the net and gross total sediment transport rates. For
additional details see the Simulation Statistics section.
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Calculating Sediment Transport Roses at Observation (Save) Points

Sediment transport roses are plots in which transport is integrated over directional
bins and plotted over a map of the site in order to observe the amount and
direction of sediment transport at a specific point. A general picture of the
sediment transport pathways can be obtained by plotting several sediment
transport roses in the areas of interest. Below is a step-by-step example for Shark
River inlet on how to plot sediment transport roses:

Setup Observational Cells

e Generate a New Coverage under Map Module and rename it as
Save Points.

e Right-click Save Points and select Type -> Model -> CMS-Flow -> Save
Points (see Figure 24).

Sene |3

| Depth (m)

Y
16.0

120

]

‘fgsgépponane
y

,,,,,,,,

8 8.0

Figure 24. Generate a new map coverage for specifying observation cells.

+

e Select save points using Create Feature Point, *

e Drag Save Points coverage under a CMS-Flow Simulation and save the
project (Figure 25).
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- E.g Map Data
[A<® Boundary Condiions
- [Z]&D Activity
--[#]&® Fow_S5
<D Spectral
[P Area Property
[F1<9 Save_Points
=16 GIS Data
-[]95 World Imagery
=L@ Annotation Data
@ Layer #1
5[5 Smulation Data
== CMS-Flow Simulations
=0 Mar2017
[1.® Aow_s5
[ Activiy
: é@ Boundary Conditions
Ce Save_Points
=-4[ ¢ Mar2017_Wind
[1,® Aow_s5
-EF2 Activity
- é@ Boundary Conditions

Figure 25. Drag Save_Points coverage under a CMS-Flow Simulation,
Mar2017.

The CMS-Flow Control (Card) File will contain a section for the observational

cells that look like this:

SAVE POINT"save pts" -1 191958 150381 HYDRO SEDIMENT SALINITY

*SAVE_POINT OPTIONS BEGIN
*SAVE_POINT NAME
*SAVE_POINT HYDRO TOGGLE
*SAVE_POINT SED TOGGLE
*SAVE_POINT SALINITY TOGGLE
*SAVE_POINT WAVES TOGGLE
*SAVE_POINT OPTIONS END

"save pts"

1
1
0
1
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Run the model

Once the model simulation has completed. The project folder will contain a
sediment flux file with the extension * trans.sp. This file contains the total
sediment transport rates in the x and y directions in units of kg/m/s.

Plot the sediment transport roses in Matlab

Exporting a Georeferenced image in SMS

If the grid is telescoping, it may be difficult to plot the grid in Matlab. There are
ways of plotting a telescoping grid in Matlab, but for the purposes of
visualization, the easiest approach is to export a georeferenced image from SMS

and plot the image in Matlab. This is done by

e Click on File | Save as... (see Figure 26)

@ SMS 12.3.3 (64-bit) - [SRLsms]
wl File Edit Display Data Cells Web Window Help

| Open... Ctrl+0
Open As...

View Data File...

Save Project (SRl.sms)
Save As...

Delete All Ctrl+N

Get Info...
Info Options...

Save Settings

E Page Setup... H
Print... Ctrl+P
Layout...

E 1 EV\ebs\...\Documents\SRljpg
2 E\Jobs\,..\Steering\SRl.sms
3 SHARKE20_HOURLY - SRI082009_DAV_1100.h3
4 SRI082009_DAV_1100.GIS
5 SRI082009_DAV_1300.GIS

Exit Ctrl+ X

Figure 26. Opening the SMS Save As window.

1. Next to Save 4s type, select JPEG Image File. Navigate to the correct
directory, enter a file name, and click Save (see Figure 27).
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@

Savein: I Steering j - £k Bl
& Name & Date modified Type

SRI 10/4/2018 10:35 AM  File folder
SRI_datasets 10/23/2018 5:48 PM  File folder

Quick access

Desktop

=3

Libraries

This PC
Py
Network

<

>
File name: [SRIgpg j Save

Save as type: |JPEG Image Fles ("jpg:"jpeg) ﬂ Cancel

Figure 27. SMS Save As window.

An image file will be saved along with a projection (*.prj) and world (*.wld) file.
The projection file contains the horizontal projection information and the world
file contains the coordinates of the image origin, the rotation angles (zero for
SMS), and pixel size. The image file can easily be loaded and plotted in SMS.

Editing and running the Matlab script

The matlab script below is just an example to show the basic steps in plotting the
sediment transport roses in Matlab. For each application, the file names,
directories, station coordinates, and settings are needed.

%Plots Sediment Transport Roses

clear all

%1. Obtain Observation Point coordinates

tel = Cms_read tel('..\Hands-on\Flow_Shark.tel");
cosang = cos(tel.angle*pi/180);

sinang = sin(tel.angle*pi/180);

%?2. Read transport file
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[gtotal, tel xx, tel yy] =read sed flux('..\Hands-on\Flow Shark trans.sp');
%3. Read and plot background image
A = imread('..\Hands-on\Image Shark2.jpg");
wld = load('..\Hands-on\Image Shark2.wld");
xi=wld(5) + (0:size(A,2)-1)*wld(1);
%SMS images are NOT rotated
yi = wld(6) + (0:size(A,1)-1)*wld(4);
imagesc(xi,yi,A) set(gca,'ydir','normal','Nextplot','add")
%~4. Plot roses, Rotate transports from local grid angle to world
for k=1:fix(size(qtotal,2)/2)
gte = qtotal(:,2*k); %East
gtn = qgtotal(:,2*¥k+1); %North
[sumx,sumy] = sumdirbin(qte,qtn);
x = ones(length(sumx),1)*xsta(k);
y = ones(length(sumx),1)*ysta(k);
h = vecplot(x,y,sumx,sumy,'marker',"V,...'lengthscale’,10,'linewidth',2,...
'MarkerFaceColor','’k','MarkerSize',3);
end
axis([1.9018 1.9257 1.4979 1.5132]*1e5)
xlabel('X, State Plane, m'), ylabel('Y, State Plane, m")
return

The subroutine sumdirbin sums the transport rates over directional bins. Note that to
integrate over time the values should also be multiplied by the output interval.
However, because the vectors are only for plotting purposes, this step is not
necessary here. The Matlab script for summing the transports in directional bins is
provided below:

function [binx,biny] = sumdirbin(u,v,binsize)
% [binx,biny| = sumdirbin(u,v,varargin)

% Sums the vector u,v in directional bins

% written by Alex Sanchez, USACE

if nargin<3

binsize = 22.5; %deg, default bin size
end
u=u(:); v=v();

mag = sqrt(u."2+v."2);
binlim = (-binsize/2:binsize:360-binsize/2)"; %olimits
bincen = (0:binsize:360-binsize)'; %centers
ndir = length(binlim);
angle = atan2(v,u)*180/pi;
angle = mod(angle,360)+0.00001;
angle(angle==0) = 0.00001;
binmag = zeros(ndir-1,1);
for k=1:ndir-1
ind = (angle>binlim(k) & angle<=binlim(k+1));
binmag(k) = sum(mag(ind));
end
binx = binmag.*cos(bincen.*pi/180); biny = binmag.*sin(bincen.*pi/180);
return
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The resulting Matlab plot is shown in Figure 28 below.

w10

T . | it .
191 o 182 1928

[
X, State Plane, m -

Figure 28. Total-load Sediment transport rates for Shark River Inlet.

Calculating Sediment Fluxes across Observational Arcs

In the CMS, sediment transport can be calculated across lines or polygons defined
by feature arcs and polygons in a post-processing procedure. The total-load
sediment transport rates calculated from CMS-Flow are integrated across user-
defined boundaries. The sediment transport statistics are calculated from the
integrated sediment transport rate. The calculated statistics are the net, gross,
positive and negative total-load sediment transport rates and are output in units of

either cy/ft or m*/m.

Calculating summed sediment fluxes over cross-sectional arcs can provide
channel infilling rates, nearshore sediment transport rates, a sediment budget
through a channel, and boundary fluxes.

e Load the solution file from CMS simulation, * trans.h5.

e Generate a New Coverage under Map Module and select Observation to
set up the map module for drawing an observational arc (Figure 29)
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Figure 29. Set up a Map coverage type to Observation.

e Zoom to the location selected for calculating sediment transport (Example
of a cross-shore location shown in Figure 30) and draw the arc using on

the Create Feature Arc tool = .

e Selecting the Select Feature Point w tool will allow modification of the
end points of the arc; or the arc can be deleted by selecting with the Select
Feature Arc & tool.

Figure 30. Example of a Feature Arc for calculating sediment transport.

Click on the starting and ending points on the grid that define the transect for
calculating sediment transport. An example of a Feature Arc for calculating
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longshore sediment transport at Shark River Inlet is shown in Figure 31. In the
case of longshore transport, the offshore end should extend beyond the breaker
zone and closure depth to capture all, mainly, wave-induced longshore sediment
transport. Be sure that the observational arc end points do not touch inactive land
cells as this may cause interpolation problems in SMS.

e The positive direction of the sediment transport is defined by the Feature
Ares direction. To view the arc direction, click on the Select Feature Arc

tool ﬁ" then click on the Feature Arc once. The arrows displayed at the
beginning and end of the transect indicate the direction of the arc which
defines the positive for all fluxes or vectors calculated across it.

Figure 31. Highlighted Feature Arc with the positive direction shown by the arrows.

e [fnecessary, the arc direction may be changed by clicking on the Select
Feature Arc tool and selecting the feature arc by right-clicking it once and
selecting the option: Reverse Arc Direction.

The sediment transport calculation across a feature arc requires a dataset of the
same size and time series length with the constant value of 1. Steps 6-8 describe
how to create a new dataset, of any scalar value, within the Quadtree Data
Module.

e To create this dataset, select the Quadtree Data Module, Click on Data,
Data Set Toolbox, Data Calculator.

e In the Data Calculator (Figure 32), select the water elevation dataset (1),
click on the Use all time steps checkbox (2), change the name of the
output dataset to ones (3), double-click on the water elevation dataset (4)
so that it appears in the Calculator window.

e In the Calculator, multiply the dataset by zero and then add one (5), select
Compute (6). The calculation might take a few minutes if the dataset is
large. Once the calculation is completed, select Done (7), and the output
dataset will appear under the Datasets window.
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Dataset Toolbox

Tools Data Calculator
B-Math Data Sets
i~ Compare datasets :‘1% Flow_55
e o v -
Angle convention
- Spatal d2. D50
P ) 6. o
" Grid Spading = d4. Manningsh
[} Temporal =3 Simulation
i~ Sample time steps ‘Eds. Waterjlevauon
i~ Compute derivative [Ear o
—Merge datzoets | d8. Morphology_Change
ConarBon [ do. x location
i Scalar to Vector { :
- Vector to Scalar d10. y location
= Modification 7 016 -
Map activity

I v il i

=

| d6:al*0+1

P | T i o
- I In | XNy | max l
| log | sqrt ] ceil I

AddtoBxpression | DetaSetinfo... | + | x| abs | foor

I
Update Available Tools Qutput dataset nam l Step 5 ! 7( Compute I
= (step7 7<= D)

Figure 32. Steps to create a time series dataset of “ones” within the Cartesian grid
module.

To obtain the sediment transport statistics, the sediment transport is first
integrated spatially to compute a time series of sediment transport across the
Feature Arc. This procedure is done in the SMS Plot Wizard. The sediment
transport vector field is interpolated to the points where the arc intercepts cell
faces and is then integrated across the Feature Arc. Follow each step outlined
below:

e Open the Plot Wizard, select Time series as the Plot Type and then Next.
In the Plot Wizard — Step 2 of 2 window, select Flux as the function type.

e Check the feature arc checkbox (Figure 33), select the ones dataset for the
scalar dataset, and sediment transport as the vector dataset, adjust to the
correct start and end times, and select Finish. (Note that the computation
might take a few minutes to tens of minutes, depending on the size of the
dataset. This is because SMS must split the vector information, which is
computationally slow.)
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Plot Wizard - Step 2 of 2

Function type: [P -

Coverage: |0bsenrahon

Starttime: [0 00:00:00

Endtime: |30 00:00:00

[™ Use calibration data Band -

Show Arcs
Ac 1

_;|I'_I'_I'_

1+

mon | Al O < >

Hep | <Back [ Fmsh |  Cancel

Figure 33. Selecting the correct Start and End Times, Feature Arcs, and
Scalar and Vector Datasets in Step 2 of 2 of the Plot Wizard.

Once the time series dataset is created in the form of the graph, the data must be
exported for calculations in other software as SMS does not yet have the
capability to do so (Figure 34). There are several programs that can process and
calculate the sediment transport statistics. One, developed by CIRP, is a simple
Fortran executable, though other programs such as Excel can do the same
calculations.
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Figure 34. Example time series of integrated sediment transport across a Feature Arc.

The Fortran executable calculates the transport statistics based on the exported
time series of integrated (along arc) transport rates obtained in the previous
section. The program can be run from a command prompt, a script file or by
simply double clicking on the executable and providing the name of the input
file. The following explains how to create the input file.

e From the generated graph, export the text data by right-clicking on the
time series plot and selecting View Values.

e From the View Values window, select the data from the table (Figure 35)
and copy-paste it to a text editor such as Wordpad or Notepad++. (Note

the number of rows in the dataset by looking at the id number of the last row
in the View Values window.)
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=

[Aﬂc 1 - ones - Total_Sediment_Transport -~
Hours Value

1 0.0 0.0

2 10 0.0

3 20 -2.580514%e-016

4 30 1.36154201e-006

5 40 0.0014286666928

6 50 0.0283612516847

7 6.0 0.1991207312542

8 70 0.5146629685313 het

Close

Figure 35. Example of a View Values window in SMS.

Save the file with the extension *.txt (Figure 36). The data may also be

saved as an * xys file (SMS xy series file), where the file needs a header

(as shown in Figure 36). Make the

second entry a file id, the third entry

the number of time steps, and the last entry a name for the time series.

{8 fluxot (E\Jobs\Workshops\Detroit\Documents) - GVIM - o X | {8 fluxxys (E\Jobs\Workshops\Detroit\Documents) - GVIM1 - o X
File Edit Tools Syntax Buffers Window Help File Edit Tools Syntax Buffers Window Help
ARRE | 0E (L nBARR/SSA|(TE9 ? 2 AERS | 9E i 0B BRR(SSAITRO(? A
0 0.0 ~[R¥5 1 721 “Curve”
1.8 0.8 8.0 A
2.0 ~2.5805149e-016 1.0 8.0
3.0 1.36154201e-006 2.0 ~2.5805149e-016
4.0 B.8014286666928 3.0 1.36154201e-006
5.0 0.0283612516847 4.0 0.0014286666928
6.0 8.1991207312542 5.0 B.0283612516847
7.0 0.5146629685313 6.0 0.1991207312542
8.0 1.8215649277594 7.0 B.5146629685313
9.0 1.3567882928984 8.0 1.0215649277594
10.0 1.5071279601087 9.0 1.3567882928984
11.8 1.3966916409451 10.08 1.5071279601887
12.0 1.202329323876 11.0 1.3966916409451
13.0 8.8526684489501 12.0 1.202329323876
4.0 0.6221763198634 13.0 085266844895 0f]
15.8 0.4727937356532 14.0 0.6221763198634
16.0 0.417855009516 15.0 B.4727937356532
17.0 0.9212770174726 16.0 0417855009516
18.0 2.8318943710385 17.8 B.9212770174726
19.0 3.3087572786703 18.0 2.0310943710385
20.0 3.7858627972056 19.0 3.3087572786703
21.0 0.9621332838786 20.0 3.7050627972056
22.0 0.4875897678773 21.0 0.9621332838786
23.0 3.1134989147918 vi22.0 B.4875897678773
“Flux.txt™ 721L, 16373C written 1,1 Top “Flux.xys" 722L, 16392C written 15,20-23 Top
Figure 36. Examples of *.txt (left) or *.xys (right) files with extracted sediment
. .
transport time series.
e Double click on the executable named proc_flux.exe (Figure 37). The

executable does not need to be in the same folder as the input file. If the
file is not in the same directory, the path should be specified before the file
name. If the path contains spaces quotation marks should be used.
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rmining outliers

Figure 37. Example calculation of sediment transport statistics using the
proc_flux.exe from a command prompt. Note the input file name contains the
directory location of the text file.

e Press Enter when the executable is finished. If no output file is specified,
the default output file name is Flux_statistics.txt. An example of the output
file is shown in Figure 38.

armRalee BERBSSA | THA|? 2

Time series name: ERRRRRRRREREEREREEEREEERERERRRREEE A
Ncur]

Time Series length: 721

Number of outliers: i}

Time series length: 30.080 days

Flux [ka] [ko/day] [kofyr]

Qin B.2561E+ 08 B.8536E+B6 B.3116E+089

Qout -0.385BE+86 -0.12B6E+85 -D.4694E+07

Ngross B.2599E+ 08 B.8664E+B6 B.3162E+09

!unet 8.2522E+ 08 0.8487E+B6 &.SﬁbVE*OQ

= v
<{ps\Detroit\Documents\Flux_statistics.txt™ 9L, 386C 9,39 All

Figure 38. Example output file of proc_flux.exe with sediment transport statistics.

Eliciting sediment transport fluxes from the CMS can contribute toward a check
of sediment transport. It is important to note that the sediment transport extracted
across an arbitrary arc is not entirely representative of the transport in the greater
area. Because the user specifies the arc manually, there is uncertainty involved in
capturing the true boundaries of transport processes over the region and should
only be used to determine relative fluxes through areas.
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Morphology

The results of the CMS calculated morphology change can be visualized several
ways, from three dimensional or planar view of the bathymetry, planar view of
the volumetric erosion and accretion, and with 1-D cross-sections of the time
series. All vector and scalar information can be extracted from points and arcs
(and polygons) in SMS. This section will cover the methodology used to post
process time series morphology change data.

To plot channel infilling in SMS in a graphical format, the results in the solution
file need to be changed from depths (the depth below the datum in which CMS
calculates) to elevations. SMS can plot multiple cross-sections, or arcs, against
each other, or through time.

Channel Infilling by cross-sections

e Load the solution file, if it does not load automatically (*morph.h5).

e Inthe Quadtree Module, click Data and Data Set Toolbox. The Data
Calculator should be selected in the Tools section as shown in Figure 39.

e Select the Depth scalar; under Time Steps check the Use all time steps on
and double-click the Depth (highlighted in Figure 39).

e The line under Calculator will display “d7:all”, add the multiplication
symbol (*) and negative 1 (-1) as shown in Figure 39.

e Change the Output data set name as shown in Figure 39 so as to
distinguish this dataset from the original Bathymetry output, click
Compute, and after the scalar set appears in the SMS window (Figure 40),
click Done. (Note: values for the contours may need to be adjusted to
view elevation range.)
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Dataset Toolbox
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Flow_S5 A
=& 2 aLz 2. 3/1/2017 1:00:00 AM
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~{£] d2. D! 4. 3/1/2017 3:00:00 AM
~[E] d3. Hord Battom 5. 3/1/2017 4:00:00 AM
4, ManwingsN 6. 3/1/2017 5:00:00 AM
5 7. 3/1/2017 6:00:00 AM
B-3 Smulaton 8. 3/1/2017 7:00:00 AM
! 9. 3/1/2017 8101
(B d. Water_Bevator 10. 3/1/2017 9
(E] pth 11, 3/1/2017 10:00:00 AM
L..[E] ds. Morphology_Change 12, 3/1/2017 11:00:00 AM
5 o 13, 3/1/2017 12:00:00 PM
{E] d5. ones 14, 3/1/2017 1:00:00 PM
[0 d10. x location 15, 3/1/2017 2:00:00 PM
16. 3/1/2017 3:00:00 PM
mdll.\‘mm 17 1{!‘!M|7arﬂnrﬂnDM b
¥ Use all time steps
 Caliaiator -
[ d7:al*(-1)
T [ T |
) ] In | Xy | max I
- | e | st | |
addtoBxpresson | Datasetinfo... | | | [
| Output datasetname: | Morphology (Elev.) Compute
Done

Figure 39. Data Calculator Options in the Dataset Toolbox.
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Figure 40. Display of calculated bathymetry now converted to elevations.
Note the legend has been modified to display the new contours.

e Create feature arcs for extracting the time series data by switching to the

Map Module button * , right-clicking Map Data

= [7]L Map Data

ault coverage
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o Click the Create a Feature Arc button ' to generate arcs from which
cross sections will be extracted and click on one side of the channel and
double-click on the other side to close an arc.

o Click the Select a Feature Arc ‘ﬂ? button and select the generated arc
(Note that there is a direction associated with the arc, which determines
the sideview of the cross section)

e Select an arc, right-click it, and select Attributes, and set the color and
name(s) of each arc which are listed together in the Observation Coverage
options (Figure 41), click OK

@ Observation Coverage X

 Fluoc M

Active | Trans | Name

Mon | mOR Delete |
Help... | ok |  Canca |

|

Figure 41. Observation Coverage attributes

e To plot the profiles in SMS, Select Display, Plot Wizard, and Observation
Profile, and select Next.

e Following Figure 42, under Coverage check one arc (though multiple can
be plotted), under Dataset(s) select Specified dataset(s) and select the
generated Morphology (Elev.) set only, and under Time step select
Specified time step(s) and check on several times spaced apart by at least
several days to months, click Finish.

e Right-click on the plot (Figure 43) and select view values.., and a table

will appear with all the plotted distance and elevations given in the graph,
(Note this ASCII table can be copied and pasted into excel.)
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Plot Wizard - Step 2 of 2 *

[ etesttin) ~Time step(s)
 Active & Speciied
Show Times -~
3/30/2017 2:00:00 PM
13/30/2017 3:00:00 PM
3/30/2017 4:00:00 PM
13/30/2017 5:00:00 PM
13/30/2017 6:00:00 PM
13/30/2017 7:00:00 PM
3/30/2017 8:00:00 PM
13/30/2017 9:00:00 PM
13/30/2017 10:00.00 ..
13/30/2017 11:00:00 ...

| 3/31/2017 120000 ..
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Figure 43. Plotted cross-section.
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e To export the data in different formats, right-click on the plot, and select
Export/Print for several options to export the graph or data from the graph
(Figure 44)

e To add more profiles or time-series, right-click on the plot, and select Plot
Data to bring up the original options from Figure 42.
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Figure 44. Data Export Options.

Analysis of cross-sectional area and sediment volume changes are the most
common approaches to quantifying morphologic change. Another method of
quantifying change in a spatial framework is through comparison of the planform
aerial change. This method is useful in delineating active zones of transport,
typically based on the depth of closure, and can define the upper and lower limits
of transport. These results can be used to interpret bypassing areas or zones,
however, determining the bypassing pathways should not be based on this
analysis alone.
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Calibration and Validation

Often, the default user-defined parameters assigned to each cell are not the best
representation of the environment. This holds particularly true for areas with
substrate bottom different than typical estuarine and littoral sands whether they
are marsh, hardbottom, or a rubble pile. The default frictional value (Mannings n,
0.025) must be adjusted to better represent the hydrodynamics in these areas. An
example in Shark

River Estuary might ““...that a much too great generality often obscures
be the very shallow, more than it enlightens and leads to calculations so
north and south up- intricate that it becomes extremely difficult to
river reaches that are deduce from them consequences even for the
dominantly marsh simplest of cases....”

platforms. These
areas flood and dry
within the tidal
range, but with a

- Leonhard Euler
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higher friction than an open sand substrate, and therefore the frictional factor must
be adjusted appropriately.

Additionally, flow in channels that are influenced by structures, such as bridge
pilings, piers, or walls, must also include some modification to the frictional
factor. For a seawall or shear wall, this is represented when the cell is designated
a “land cell”; however, if your structure is much smaller than cell size an
alternative option would be to increase the friction factor to imitate the frictional
forces of that structure. This was done in an earlier section describing the bridge
pilings located at three bridges crossing the main channels are Shark River Inlet.

ChecKklist

Below is a checklist for common issues that should be addressed during the initial
calibration process.

1. Check the Bathymetry. The most common mistake in bathymetry is
improper conversion to the common vertical datum. This will result in
jagged triangulation within the grid, or a large increase or decrease that
resembles a morphologic feature such as a shoal but is in fact just poor
datum control. Sometimes the horizontal datum may be off by a small
margin. For example, many Federal Agencies still collect spatial data in
NAD27 instead of the NADS3, and from a large scale these can easily be
confused.

2. Grid dimensions. Does the grid cover the reaches it needs to support
proper tidal prism, littoral range, and cover enough area to provide room
to calculate large wave and hydrodynamic gradients and to avoid
boundary interference for interior calculations?

3. Timing. Setting up the proper dates and times in the model control is
crucial in calibration. Common mistakes include missing the measured
time period in the forcing or the model period, not coordinating all
forcings, and improperly interpreting the SMS output date and time
intervals. Also, beware the differences between local time and Global
Time (GMT/UTC).

Statistics

Statistics can be calculated on the equidistant measured and calculated profiles.
There are many statistical approaches to compare the measured and calculated
data for hydrodynamics. Of those approaches Correlation Coefficient, Root Mean
Square Error (RMSE), Normalized or Relative Root Mean Square Error
(NRMSE) are commonly used for interpreting goodness of fit for hydrodynamic
measurements. The Brier Skill Score and Correlation Coefficient methods are
often used in evaluating bathymetry change over transects or morphologic
differences such as volumetric change for morphologic features.
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